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LEGAL DISCLAIMER 

 
While all attempts have been made to verify information provided in this 

publication is correct at the time of sale, the author does not take 
responsibility for errors, omissions or contrary interpretations of the 
subject matter herein.  

 
This publication is not intended as advice for any specific person, but 

rather a general source of reference for matters pertinent for podcasting.   
 
The author is not responsible or liable whatsoever on the behalf of any 

purchaser or reader of these materials.  
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No part of this publication (including the letters) may be reproduced or 
transmitted in any form or by any means, mechanical, or electronic, 
including photocopying and recording, or by any information storage and 
retrieval system. 
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HOW TO CREATE A FREE PODCAST 

SHOW TODAY! 

1. WHAT YOU MUST HAVE 

You must have a microphone (of good or better quality) and a computer with internet 

access. 

Whether you are on a MAC or a PC, if you have the two above items, you can create 

your first FREE podcast show today. 

2. IS THERE NO COST AT ALL? 

No, there is no cost at all if you have the items in number above all ready to go. 

3. WHAT DO I HAVE TO DO TO CREATE MY FREE FIRST PODCAST 

SHOW? 

Here are the four  steps you need to take to create  your first FREE podcast show 

today: 

1. Create a podcast show format plan. 

2. Record, edit and save the audio in Audacity. 

3. Export the audio media file as an MP3 file (or video as a MP4). 

4. Upload your media file to a FREE hosting company website like Podbean 

which will then publish it to iTunes for you. 

That’s all you “have” to do, but you can do extra things like create some nice “cover 

art” which is the image that is saved with your podcast show and seen inside iTunes 

when people browse through iTunes, the first thing they see is the cover art.  So it 

can be worthwhile to also do this step.  If you don’t have cover art, you can still 

publish your podcast show though.  
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4. DOES IT MATTER THAT I HAVEN’T SPENT ANY MONEY ON MY 

PODCAST SHOW? 

No, it definitely doesn’t matter, however, long term, no podcaster would continue with 

a free service.  So using a free service is a great idea if you are not sure whether to 

go ahead with a podcast show or not yet.  But, when you feel your podcast show is 

gaining momentum, you should change over to a paid hosting site like 

http://libsyn.com/ or http://www.blubrry.com/ . 

When you are ready to take your podcasting to another level, you should also check 

out the Fast-Track Podcast Show Creation Video Workshop I created to get budding 

podcasters set up and podcasting very quickly, with professional video training, and 

heaps of extra tips too http://www.bloggerswhopodcast.com/  

5. CREATE THE PODCAST SHOW MEDIA FILE 

Because of the size of video files, if you want to create a free podcast show it will 

have to be audio to publish on iTunes. 

There are other benefits to recording audio only, including that it is quicker and 

usually much easier to create than videos. 

If you want a video podcast because you want to also publish your videos on 

YouTube, you should consider converting your audio recording into a video. 

FORMAT 

You need to decide on what you are going to talk about in your podcast show, how 

long it will go, and who else will be involved (or are you going alone on this project).  

For example you could: 

- Record your voice talking about something 

- Do a training tutorial 

- Record you and someone else talking together (like an interview) on Skype 

AUDIO 

My advice for newbie podcasters, just go with audio for beginners.  Why? 

http://libsyn.com/
http://www.blubrry.com/
http://www.bloggerswhopodcast.com/
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- It’s easier to plan an audio show 

- It’s easier to prepare  

- It’s quicker to record 

- It’s easier to edit 

- It’s quicker to upload and publish 

What will you need to record an audio MP3 media file? 

a) A good microphone (you can get good mics from Amazon.com for under $50) 

b) Computer with Internet connection  

c) Software to record, edit and save as an MP3 

d) A hosting site 

e) An iTunes account 

f) A blog 

g) A Feedburner account  

VIDEO 

There are pros and cons of creating a podcast show with video. 

PROS: 

You can list it on YouTube, and you can save it as an MP3 and upload only the MP3 

on your podcast. 

CONS: 

If you want a FREE podcast show, you won’t find a FREE host for your media files.  

This is because videos are so high in memory to host it and it takes a lot of bandwith 

when people download it. 

Other considerations when you create a video 

For example, if you are creating a show that has to be video, then you need to also 

consider your: 

- Lighting 

- Sound 

- Recording device (ideally HD) 
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- Any actors “appearance” (eg. Hair and make up) 

Once you have created your media file, you need to save it in the correct format to 

be uploadable to iTunes.  For audio it is MP3, and for Video it is MP4. 

Podcast Show Format inspiration 

Go have a look around the iTunes Store and see if any of the other podcast shows 

you see there inspire you somehow.  Always try to think like a listener who you  want 

to attract to your show.  What do they want to listen to, what do they want to learn, 

are they interested in serious conversations, or light-hearted fun stuff. Do surveys of 

people you want to target to see what they say themselves.   

Podcast Shows can be: 

- Interviews 

- Talk Back 

- Promotions 

- Charity & Fund Raising 

- How To Tutorials 

- Religious 

- Inspirational 

- Educational 

- Political 

- For kids/adults 

- Pure and simple entertainment 

To record and save your media files as MP3 

Once you have downloaded the Audacity program and saved it to your PC/Mac, then 

you are ready to start. 

AUDACITY LESSON ONE – Download and run Audacity & Lame Plugin 

You should go into http://audacity.sourceforge.net/download/ and download a free 

software recording program called Audacity.  You can download this for a PC, a 

Mac, or GNU/Linux. 

http://audacity.sourceforge.net/download/
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If you own a Mac, you could just use Garageband.  If you are using Audacity, you 

should also head back to Audacity website, and download the “Lame” plug in. 

http://manual.audacityteam.org/o/man/faq_installation_and_plug_ins.html#lame.   

Once you have installed that onto your PC/Mac as well, then you are ready to save 

your media file as an MP3 file, and upload it to your host.  

AUDACITY LESSON TWO – Open Audacity and record your audio 

 

Once you have Audacity saved to your PC/Mac, then you should open the program 

up.  The icon will look like this one on your desktop. 

Remember, you don’t have to use Audacity, its just that it is FREE, and it is 

considered a top quality product for newbie podcsters. 

They do have a support forum, and there are many free tutorials on Audacity on 

YouTube.  You should always head over there anytime you get stuck with 

something. 

Another place you can seek help is at Daniel J. Lewis’ blog 

www.theaudacitytopodcast.com/ . 

http://manual.audacityteam.org/o/man/faq_installation_and_plug_ins.html#lame
http://www.theaudacitytopodcast.com/
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The above image is a screenshot of how your Audacity program will look 

(dashboard) when you first open it up to record your audio. 

 

The above image is a close up of the top navigational bar of Audacity. 

 

The above image is a close up of the record/edit buttons you need to push when 

appropriate to record and stop recording your audio.  The buttons are from left: 

Pause – Play back – Stop – Back to start – Up to end of recording – Stop. 
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When you are ready, simply push the red “Record” button and start talking.  If you 

need to stop and think about things, you should simply push “Pause” – not “Stop”.  If 

you choose “Stop” it will cut the recording there, and when you push “Record” again, 

it will record it into a new line.  If that happens, it doesn’t really matter because at the 

end all the recording will be combined, however, when you start editing it might muck 

around your start/stop points, therefore, I’d try to keep my recording all in one singe 

line. 

So go ahead and try it out a few times.  In particular, you want to check your “tone”, 

the loudness of the recording and any “noise” that may be affecting your recording 

sound quality. 

 

As you record your voice, you will notice the waveform (blue) move up and down 

with your voice levels as you record.  This is normal. 

I suggest you record your show from beginning to end, and take your time, repeat 

lines you’re not sure about, and complete the recording in one waveform. 
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AUDACITY LESSON THREE – Edit your recording in Audacity 

Then when you have finished, go back to the beginning of the recording and push 

“Play”. 

As you listen, you need to look out for the following problems in your recording and 

edit them as soon as you can: 

1. Heavy breathing (or breaths) 

2. Um’s 

3. You know’s 

4. Uncomfortable lengths of space between sentences 

Any other annoying or unprofessional sounds/noises that you find as a result of 

playing back your recording. 

 

In order to edit the above circumstances, you will need to get familiar with the above 

editing tools. 

The main tools you will use are the “Scissors” (to the far left) and the fifth button in 

from the left, the “Silence” button.  As you hover over all Audacity buttons, including 

these ones, the name of the button will pop up. 

Scissors (delete) 

To use the scissors, simply select the part of the footage that you want to delete by 

clicking at the beginning of the recording, and dragging your mouse over to the end 

of the part you want deleted.  It will highlight the footage.  Then go and click on the 

scissors, and it will delete the footage. 

You can also delete by highlighting the section and just clicking on “delete”. 

(NB.  If you make a mistake, simply “undo” that last error, in fact, you can “undo” 

many steps back if you have to – “undo” is found under the top navigational bar “edit” 

OR in the navigational tool bar above right under the microphone image). 
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Silence tool 

To use the “Silence” tool simply do the same as for scissors, but click on “Silence” 

instead of “Scissors”.  It will flat line the recording for that highlighted section. 

Other helpful tools to know about 

The other important tools are “Zoom in” and “Zoom out” which are the magnifying 

glasses above with the + for zoom in, and – for zoom out. 

Above the tools we have already mentioned, are volume controls. 

 

To move the waveform left or right, you need to change your “handle button” from 

the tall “I” under the word “Analyze” in the top navigational bar, to the double ended 

“arrow” in between the “magnifying glass” and the “star”. 

You need to change it back and forth a few times when you are editing. 

The above tools are only the basic tools, and as you record more and more shows, 

you will start to learn more about the other features of Audacity.  There are many 

professional podcasters who still use Audacity (and Garageband), these are highly 

regarded programs, so you should proceed with confidence. 

Further training for Audacity 

There are plenty of current training tutorials for Audacity and Garageband on 

YouTube.   

AUDACITY LESSON FOUR – Save your recording as an MP3 

Saving your project, and exporting your file are two different things, and you should 

do both.  This is always helpful if your “export” attempt fails and you need your 

original audacity media file to re-export.  Saving regularly is important, if you lose a 

document, you can re-type it, but you can’t reinvent an interview, you would have to 

“re-interview” that person to replicate that media. 
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Saving your Audacity Project 

 

To “Save” your Audacity recording, you should go to “File” and “Save Project”, and 

the above box will open up, you select “Save as type:  Audacity projects (*.aup) – 

and click on “Save”.  This action will save your project as an “Audacity” file, and that 

file is only good to use in Audacity.  

Exporting your Audacity recording as an MP3 
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If you want to use this recording outside of Audacity, you need to “Export” it.  When 

you download Audacity, it does not have the ability to save as an MP3.  This feature 

is under a separate licence, and as such, Audacity could not build the feature into 

their software. 

If you have downloaded the “Lame” program as well, then this feature should be set 

up ready to go, or it may require a few simple set up instructions the first time only.  

From then on, when you go under the “File” menu, and drop down to the “Export” 

option, then the above image will pop up.  Once it does, you should save your 

recording as an “MP3 Files”.   

This is the format you need to upload your recording to your media host site in. 

6.  FREE MEDIA FILE HOSTING & PUBLISH YOUR PODCAST SHOW 

You need to go find a FREE podcast show hosting company to host your podcast 

shows. 

At the moment, one of the popular websites is PODBEAN. 

You should go to www.Podbean.com and open a FREE account. 

 

 

 

You can now customise your Podbean account.  This should include: 

 

- Setting up your “privacy” on your account (public or private) 

- Upload a logo for your account 

- Choose a channel title, category, tags and description 

http://www.podbean.com/
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Publishing 

 Upload your media file to Podbean 
 Monthly Growing Space 

Theme Customisation 

 Change your theme 
 Use your own header image 
 Arrange your sidebar by widgets 

iTunes 

 iTunes settings and preview 
 Submit podcast to iTunes 

Statistics 

 Episode hits 
 Subscribers 
 Site visitors 
 GEO stats 

Embeddable Player 

 Embed podcast everywhere 

Account Settings 

 Change your name, password and email 
 Change account plan 
 Set your own domain 

Basic Podcast Settings 

To change some of your basic settings, log into your account by going to 
http://podbean.com/login. This will take you to the main Dashboard where you can 
find links to all the various settings and publishing tools. Click the "Settings" tab 
located in the upper right menu bar. You'll then see the "General Options" page. 

http://podbean.com/login
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From here, you can make a number of changes: 

Channel Privacy - Choose whether you'd like your podcasts to be available to the 

public or just to friends that you invite to Podbean. 

Change Your Logo - When you first sign up for your Podbean account, your logo is 
set to the default Podbean image which looks like this: 

This image is displayed prominently on your podcasting website so you may 
customize it to your own wish. clicking the "Upload your own logo" link to upload your 
logo image file. Then select it from the drop down menu. Please notice your logo 
image file size cannot be larger than 200K. If your image file is larger than 200K, it 
will not be shown in the list. After selecting the logo image, click the "Update 
Options" button at the bottom right of the General Options page and you're done! 
Your new logo has been added!  

 

Channel Title - The Channel Title is essentially the "name" of your podcast. It can 
be anything you choose, from your user name or online identity to a phrase, 
company name or other unique identifying label. 

Channel Category - The Channel Category indicates where your podcast account 

will be listed in the Podbean directory. Podbean defaults to the "General" category 
but you can change this by clicking the dropdown box next to "Channel Category" 
and choosing the listing that's appropriate for you. 
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Channel Tags - Channel tags are like keywords that help visitors to the Podbean 
site find your podcasting account. If you want your podcasts to be available to the 
public, then you'll also want to choose a few keywords or keyphrases that are 
relevant to your podcast. For example, a podcasting site that focuses on blogging 
and internet marketing might want to use tags such as "blogging", "internet 
marketing" and "search engine optimization" (without the quotation marks, of 
course). 

Brief Description - The description will be shown in the header of your podcasting 
site just below your Channel Title. 

You can also use this page to update your email address as well as set your local 
date and time. Once you've made your desired changes, just click "View Site" at the 
top left of the page and check out your modifications! 

Publishing 

Like everything else in Podbean, putting up new podcasts is easy as can be. The 
first thing you'll need to do is record your podcast using your favourite software and 
equipment. When you're ready to upload, just go to your main Dashboard and click 
the "Publish" link in the upper left-hand corner. You'll see a screen that looks like 
this: 

Tags - Tags are "labels" for your post that help people find your podcasts by 
searching specific keywords or key phrases. 

Title - The name of your podcast. 

Post - If you want to add an introduction or some extra content to go with your 
podcast, this is the place to do it. This is a user-friendly composition interface that 
works similar to most word processing programs, so you can bold and italicize your 
text, add images, etc. 

Add Media File - This section is the place for you to set your podcast media files 
(ex: audio, video). There are two ways to add your media files: choose files that have 
already been uploaded from the drop-down box, or click the "Browse" button to 
upload a file directly, Please note files larger than 30MB in size will need to be 
uploaded via FTP(see below) first. Once the media file is targeted, you may set its 
attribute such as type, length etc.  
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To save this post for later, just click "Save and Continue Editing" if you want to make 
more changes or "Save" if you're done for now. To publish, click the "Publish" button 
and viola! You're published! 

HTTP Upload - Upload via HTTP is simple. Just navigate to "Upload > Media 
Manager", click the upload button and follow the steps. The 30MB file size limitation 
is also applied here. 

FTP Upload - To add files via FTP, you'll need your FTP user name and password 
for your Podbean account. This is not the same as the user name and password that 
you use to sign into Podbean and it may change periodically for security reasons. Go 
to your Account page by clicking the "Account" link at the top right-hand side of your 
Dashboard page and you'll find your current FTP login information. 

Now, you can FTP your files with any size. We recommend Filezilla for Windows 
and Fetch for MacOS. 

Once your files have been uploaded, return to your main Dashboard in your 
Podbean account and click the "Upload" tab in the top left menu: 

Click the "Import FTP uploaded files" button to move your files over to your account. 
Note that you need to import your files within 24 hours of uploading them via FTP. 
After 24 hours, the files will be deleted from the FTP server. 

Monthly Growing Space 

To make sure you always have enough podcasting space, Podbean offers free 
monthly growing space to premium customers. What does that mean for you? 
Instead of trying to figure out which files to delete so that you can upload more, you 
can simply increase your space to accommodate all of your podcasting media files.  

How does this work? 

Instead of just giving you a set allotment each month, Podbean chose to make the 
growing space responsive to your needs. To do this, we've created a process that 
allows you to add the amount of space you need when you need it. Here's how it 
works: 

Login to Podbean where you'll see your main Dashboard page. Click the "Upload" 
tab in the upper right-hand menu. You should now be at your Media Manager page. 
This is the place for you to manage your uploaded files. 

http://filezilla-project.org/download.php?type=client
http://www.fetchsoftworks.com/
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In the box marked "Current Media Files", you'll see a list of the files that have been 
uploaded to your account. Click the "Archive" button beside a file and it moves to the 
"Archived Media Files" box. You've just given yourself some extra space! You can 
archive as many files as you want until the total archived files size is greater than 
your monthly growth limit. The archived quota will be reset to zero at the end of each 
monthly cycle. 

And don't worry... your archived files are still available for public viewing and can be 
used as normal files. "Archive" just move the files to a permanent storage space.  

Theme Customisation 

Podbean makes it easy to customize your Podbean site! From your main Dashboard 
page, click the "Layout" tab in the upper left-hand menu: 

From here, you can modify your theme, your header image, your sidebar, 
bookmarking options and links. Advanced users can also edit their CSS from this 
page. 

Change Your Theme 

When you click the "Layout" button, you should see the "Themes" subsection of the 
Layout area. Here you can see your current theme as well as all your available 
options. Podbean has a number of themes to choose from so if you want to change 
yours, just click on the theme of choice and you're ready to go! 

Use Your Own Header Image 

Next to Themes, you'll see a subsection link called "Header Image". Click this tab 
and you'll see your current header image used by the theme of your choice.  

If you want to change this, simply upload a new image by clicking the "Browse" 
button to find your image file. Then click "Upload" to process the new image. 

Arrange Your Sidebar 

Arrange your sidebar layout is as easy as drag-n-drop. To do this, simply click the 
"Sidebar Widgets" tab under the Layout menu. 

You'll see sidebar components listed under "Available Widgets" - just click and drag 
them where you'd like them to be on your sidebar "block". If your chosen theme has 
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two sidebars, then you've got two "blocks" to work with. You can add, remove and 
change the order of these widgets as much as you like. 

And if you're thinking you'd like to leave your sidebar just the way it is, go ahead. 
Your theme comes with a default layout so no changes are necessary to keep your 
current layout. 

iTunes 

Submit your podcast to iTunes gives you more chances to be known by worldwide 
audience. To do this, you'll need to configure iTunes related settings under menu 
"Settings > Feed/iTunes" 

The "iTunes Preview" window shows you exactly how your podcast will appear in 
iTunes. The corresponding settings are shown below: 

iTunes Settings: 

iTunes: FeedID - This is the ID you'll receive after you register your podcast service 
with the iTunes Music Store. 

iTunes: Summary - This defaults to your Podbean podcast description found on 

your "Settings > General" page, but you can change it for your iTunes listing by 
editing this box. 

iTunes: Podcast Logo - This defaults to your default logo for your Podbean account 
but you can change it here for your iTunes listing by using the drop down box to 
choose another image. 

iTunes: Author/Owner - The creator/owner of the podcast. 

iTunes: Subtitle - Give your podcast a subtitle (optional) 

iTunes: Keywords - These default to the channel tags you created when you 
uploaded your podcast. 

iTunes: Category - iTunes allow you to select up to 3 categories. 

iTunes: Email - This defaults to your registered Podbean email but you can change 
it here if you want. 
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Once you finished those settings, now it's ready for you to submit your podcast to 
iTunes. 

Statistics 

Want to see how your podcasts are performing? Podbean's powerful analysis tools 
gives you an in-depth dimensional view of your visitors, subscribers, hits and 
geographical distribution. 

Navigate to top menu "Statistics", each submenu represent a specific type of 
podcast stats. Includes episode hits, subscribers, site visitors and geographic 
distribution. 

Episode Hits - Hits for each episode. different type of reach will be categorized 
three areas: feed, download and streaming. Feed reflects the number of times your 
content is fetched via a subscribed Feed; Download is the number of times that your 
content files are downloaded directly through the web; While streaming is the 
number of times that your content files are played online. 

Subscribers - Approximate measure of the number of individuals currently 
subscribed to your feed. It's based on an approximation of how many times your feed 
has been requested by many different feed readers (ex:google reader) and 
podcatchers (ex:iTunes) in a 24-hour period. Request from robots will not be 
counted. 

Site Visitors - Provide the number of visitors to your podcast site. Any number of 

visitors with the same IP address will be counted only once in a 24-hour period. 

Geo Stats - The measure of where the audience comes from. 

Each stats consists of graphic view, summary, and raw data, which are generated 
based on the criteria at the top of the page. 

Embeddable Player 

Eager to share your podcast to millions users in Facebook, MySpace, or integrate to 
your own blogs and websites? The embeddable Player is just designed for this 
purpose. The unique feature "Embed Once, Use Forever" let you only do a simple 
Copy & Paste and the playlist will be updated automatically in the future. 
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Embed Podcast Everywhere - To get the embed code of your Podcast Player, 
simply click "Manage" tab, then "Embeddable Player" sub-tab. For Facebook user, 
click the link for Facebook and follow the steps. For other websites, select the colour 
and size of the player and click "Get Embed Code". Note there is a link "MP3 Audio 
Player" besides the headline of the page. This is an audio player with similar 
features, but only collect the episodes with MP3 audio format. 

Embed Single Episode - To get the embed code of the Podcast Player for a single 
episode, you click "Manage" tab, then "Posts" sub-tab, click the "embed code" button 
at right side of the post. 

Once a new publish is done, some backend works are needed for player to get 
updated, such as video encode, generate thumbnail and regenerate the playlist etc, 
which may take up to 24 hours. 

Account Settings 

To change your email address, first and last name or to create a new password, click 
the "Account" tab in the upper right-hand menu bar from your main Dashboard page. 
Make your changes and then click "Update Account" at the bottom of the page. You 
can also upgrade your Podbean account from this page as well as set your own 
domain.  

7. WRAP UP 

That’s it!  Once you have your first show up, then you set about recording another, 

and another and another. 

How you create your podcast show strategy is up to you, and you should always 
consider what you audience would most want to hear, always think like your 
audience, and your podcast show subscribers and downloads will continue to grow, 
indefinitely. 

Good Luck with your Podcast Show! 

 


